
 

Upgrading the Cisco ONS 15600 SDH to       
Release 9.2.1

This document explains how to upgrade the Cisco ONS 15600 SDH Cisco Transport Controller (CTC) 
software from Release 8.0, 9.0, 9.1 to Release 9.2.1.x, using the Timing and Shelf Controller (TSC) card. 
The Cisco ONS 15600 SDH CTC support upgrades from R9.2.1.1 and R9.2.1.2 to Release 9.2.1.3.

Note To upgrade from Release 1.4 to Release 9.2.1.x, a step upgrade to Release 8.0 must be performed.
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  Before You Begin
Caution Read each procedure before you begin the upgrade.

Caution This document supports upgrades from Software R8.0 to Software R9.2.1.x.

Document Procedures
Procedures in this document must be performed in consecutive order unless noted otherwise. Ensure that 
the procedure is completed for each node in a given network. If you are new to upgrading the 
ONS 15600, make a printed copy of this document and use it as a checklist.

Each non-trouble procedure (NTP) is a list of steps designed to accomplish a specific procedure. Follow 
the steps until the procedure is complete. If you need more detailed instructions, refer to the detail-level 
procedure (DLP) specified in the procedure steps. Throughout this guide, NTPs are referred as 
“procedures” and DLPs as “tasks.” Every reference to a procedure includes its NTP number, and every 
reference to a task includes its DLP number.

The DLP (task) supplies additional task details to support the NTP. The DLP lists numbered steps that 
lead you through completion of a task. Some steps require that equipment indications be checked for 
verification. When a proper response is not obtained, a trouble clearing reference is provided.

The following NTPs are contained in this document:

1. NTP-U487 Preparing to Upgrade to a New Release, page 2—This procedure contains critical 
information and tasks that you must read and complete before beginning the upgrade process. 

2. NTP-U506 Back Up the ONS 15600 SDH Software Database, page 4—Complete the database 
backup to ensure that you have preserved your node and network provisioning in the event that you 
need to restore them.

3. NTP-U507 Upgrade the ONS 15600 SDH Software, page 6—You must complete this entire 
procedure to complete the upgrade.

4. NTP-U508 Restore the Previous Software Load and Database, page 17—Complete this procedure if 
you need to return to the previous software load.

5. NTP-U509 Upgrade to the ONS 15600 SDH Software Using TL1, page 19—Complete this 
procedure to install the ONS 15600 SDH software using Transaction Language 1 (TL1).

NTP-U487 Preparing to Upgrade to a New Release

Purpose This procedure steps you through the critical information checks and tasks 
you must complete before beginning an upgrade to R9.2.1.x.
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DLP-  U573 Verify CTC Workstation Requirements
Step 1 Read the Release Notes for Cisco ONS 15600 SDH Release 9.2.1.

Step 2 Using the CTC software, log into the node that you are upgrading. For detailed instructions, refer to the 
Cisco ONS 15600 SDH Procedure Guide. 

Note You cannot open an SDH node in the same CTC session where a SONET node is active.

Step 3 Complete the “DLP-U573 Verify CTC Workstation Requirements” task on page 3.

Step 4 Disable all other Ethernet devices (such as a dial-up adapter) on the workstation that runs CTC. For 
instructions, contact the Cisco TAC.

Note If you have multiple IP addresses on your workstation, you should remove them; you cannot run 
ONS 15600 SDH Software R9.2.1.x if multiple IP addresses are configured. 

Step 5 If you have multiple ONS 15600 SDH nodes configured in the same IP subnet, ensure that only one is 
connected to a router. Otherwise, the remaining nodes might be unreachable. Refer to the 
Cisco ONS 15600 Reference Manual for LAN-connection suggestions.

Step 6 Verify that TSC cards are installed in Slots 5 and 10, and that the TSC in Slot 10 is active.

Step 7 If the TSC in Slot 5 is active, select the slot, and right-click to display a shortcut menu. Click the Soft 
reset Card button. The reset takes a few minutes, and resets the TSC card in Slot 10 as the active TSC.

Step 8 Complete the “NTP-U506 Back Up the ONS 15600 SDH Software Database” procedure on page 4.

Stop. You have completed this procedure.

DLP-U573 Verify CTC Workstation Requirements

Tools/Equipment • PC or UNIX workstation

• Cisco ONS 15600 SDH nodes to upgrade

• Cisco ONS 15600 SDH Software R9.2.1.x (CD or soft copy)

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task verifies that all PC or UNIX workstation hardware and software 
requirements are met.

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser
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DLP-  U573 Verify CTC Workstation Requirements
Step 1 Ensure that your workstation is one of the following:

• IBM-compatible PC with a Pentium IV or faster processor, CD-ROM drive, a minimum of 1 GB 
RAM and 250 MB of available hard drive space, Windows 2000 Professional, Windows Server 2003 
and 2008, or Windows XP Professional.

Note To successfully run the CTC on workstations running Windows Vista or Windows 7, upgrade the CTC 
Software to R9.0 or later. Releases prior to R9.0 are not supported on Windows Vista or Windows 7.

Note Use the latest patch or service pack released by the OS vendor. Check with the vendor for the latest patch 
or service pack.

• UNIX workstation with Solaris Version 9 or 10 on an UltraSPARC-III or faster processor, with a 
minimum of 1 GB RAM and a minimum of 250 MB of available hard drive space.

Step 2 Ensure that your web browser software is one of the following:

• Netscape Navigator 7.x or higher on Windows

• Internet Explorer 6.x or higher on Windows

• Mozilla 1.7 or higher on Solaris

Step 3 Verify that the Java Version installed on your computer is Java Runtime Environment (JRE) 1.5.0; higher 
versions of Java will not run CTC for the ONS 15600 SDH R8.0.

Note To check your JRE version, type the node IP address in the Address field of your browser and 
then look at the JRE version listed under the Java Environment label. If you need to install JRE 
1.6.0, go to www.java.com and follow the instructions on the site to download and install the 
JRE 1.6.0 package.

Step 4 Verify that the correct Java Policy file is installed on your computer. 

Note For important information about how CTC backward compatibility is affected by your choice of 
JRE versions, see the Readme.txt or Readme.html file on the software CD.

Step 5 Return to your originating procedure (NTP).

NTP-U506 Back Up the ONS 15600 SDH Software Database

Purpose This procedure preserves all Software R8.0 configuration data for your 
network before performing the upgrade.
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DLP-  U573 Verify CTC Workstation Requirements
Note Multiplex Section-Shared Protection Ring (MS-SPRing nodes only) The database must be backed up prior 
to locking the MS-SPRing. To restore a software database, a backup file of that database must be 
available. 

Step 1 Log into CTC. For detailed instructions, refer to the Cisco ONS 15600 SDH Procedure Guide. If you are 
already logged in, continue with Step 2.

Step 2 In CTC node view, click the Maintenance tab and then click the Software button.

Step 3 Verify that the correct working and protect versions of the software are installed.

Step 4 (Optional) Cisco recommends that you manually log critical information by either writing it down or 
printing screens where applicable. Use Table 1 to determine the information you should log. Complete 
the table (or your own version) for every node in the network. 

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures NTP-U487 Preparing to Upgrade to a New Release, page 2

Required/As Needed Required

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Maintenance and above

Table 1 Manually Logged Data

Item Record Data Here (If Applicable)

IP address of the node

Node name 

Timing settings

Data Communications Channel (DCC) connections; list all 
optical ports that have DCCs activated

User IDs (List all, including at least one Superuser)

Inventory; do a print screen from the Inventory window

Active TSC

Note The TSC card in Slot 10 must be the active TSC card for 
an upgrade.

Slot 5 or Slot 10 (circle one). If the 
TSC in Slot 5 shows active status, 
the slot and right-click to display a 
shortcut menu. Click Soft reset 
Card. The reset takes a few 
minutes, and resets the TSC card in 
Slot 10 as the active TSC.

SSXC preferred copy Slot 6/7 or Slot 8/9 (circle one)

Network information; do a print screen from the Provisioning tab 
in network view.

Current configuration: SNCP, linear, etc. Do print screens as 
needed.

List all protection groups in the system; do a print screen from 
the Protection Group window.

List alarms; do a print screen from the Alarm window.

List circuits; do a print screen from the Circuit window.
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DLP-  U573 Verify CTC Workstation Requirements
Step 5 In CTC node view, click the Maintenance tab and then click the Database button.

Step 6 Click the Backup button.

Step 7 In the Database Backup dialog box, click the Browse button, then navigate to a local PC directory or 
network directory and type a database name (such as database 10101882010107.db) in the Select file for 
saving backup field. 

Step 8 In the Database Backup dialog box, click the OK button. If you are overwriting an existing file, click 
Yes in the confirmation dialog box.

Step 9 In the Database Backup dialog box, check the Alarm History and the Performance check boxes in order 
to choose these database items in addition to provisioning information. 

Note The Provisioning selection in the Database Backup dialog box is a default component of the 
backup file, and this selection is dimmed.

Step 10 Save the database on the workstation's hard drive or on network storage. In the Database Backup dialog 
box, click OK.

Step 11 A message indicates the status of the backup. When the backup is complete, click the OK button to close 
the message dialog box.

Step 12 Repeat Steps 1 through 11 for each node in the network.

Stop. You have completed this procedure.

NTP-U507 Upgrade the ONS 15600 SDH Software

Note To upgrade the software successfully, read and perform each task that applies to your network in the 
proper order. 

Caution Executing an upgrade with only a single TSC card present in the node is traffic-affecting. Do not start 
an upgrade unless both TSC cards are present and are alarm free.

Purpose This procedure upgrades the node software to Software R9.2.1.x.

Tools/Equipment PC or UNIX workstation; Cisco ONS 15600 SDH Software R9.2.1.x (CD 
or soft copy)

Prerequisite Procedures (MS-SPRing nodes only) The database must be backed up prior to locking 
the MS-SPRing. See NTP-U506 Back Up the ONS 15600 SDH Software 
Database, page 4

Required/As Needed Required

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser
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DLP-  U573 Verify CTC Workstation Requirements
Note The UPGRADE, SFTWDOWN, and SW-VER alarms are raised during the upgrade process. These 
alarms are normal and will clear when the download is complete.

Step 1 Install and run the JRE 5.0 version. Software R9.2.1.x does not run with lower versions of the JRE. 

Step 2 Insert the Software R9.2.1.x CD into the workstation CD-ROM (or otherwise acquire access to the 
software) to begin the upgrade process.

Note Inserting the software CD activates the CTC Setup Wizard. You can use the Setup Wizard to install 
components or click the Cancel button to continue with the upgrade without the wizard.

Step 3 Log into the ONS 15600 SDH node that you want to upgrade. For detailed instructions, refer to the 
Cisco ONS 15600 SDH Procedure Guide. If you are already logged in, continue with Step 3.

Step 4 (MS-SPRing nodes only) Complete the “DLP-U574 Perform an MS-SPRing Lockout” task on page 8.

Note The MS-SPRing lockout must be completed for all nodes in all rings where the ONS 15600 SDH 
is provisioned. The database must be backed up prior to locking the MS-SPRing. 

Step 5 Complete the “DLP-U575 Download the ONS 15600 SDH Software” task on page 9.

Step 6 Complete the “DLP-U576 Activate the New ONS 15600 SDH Software” task on page 11.

Step 7 If you have trouble logging back into a node after software activation, complete the “DLP-U577 Delete 
Cached JAR Files” task on page 13.

Step 8 Reconnect to the node using CTC. The new CTC applet for Software R9.2.1.x uploads. 

Step 9 During CTC login, complete the “DLP-U578 Install the Public-Key Security Certificate” task on 
page 14.

Caution After you have accepted the Software R9.2.1.x build and both releases are present in the working and 
protect fields on CTC, you cannot revert to Software R8.0 without downloading Software 8.0 or 
installing the Software R8.0 PKG file and restoring the Software R8.0 database.

Step 10 Complete the “DLP-U579 Accept the New Load” task on page 15.

Step 11 Repeat Steps 6 through 10 for all nodes in the network that need to be upgraded. Allow each node to 
finish. Wait until all alarms have been cleared for 10 minutes before activating the next node.

Note Activate only one node at a time.

Step 12 Complete the “DLP-U580 Remove the MS-SPRing Lockout” task on page 15 for all MS-SPRing nodes 
in the network.

Step 13 (Optional) Use this step only if you wish to ensure that a software revert to the previous software release 
is no longer possible. Complete the “DLP-U575 Download the ONS 15600 SDH Software” task on 
page 9 again for all nodes, or groups of nodes you are upgrading. 

Step 14 Complete the “DLP-U581 Set the Date and Time” task on page 16 for any nodes that are not using 
Simple Network Time Protocol (SNTP).
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DLP-  U574 Perform an MS-SPRing Lockout
Step 15 As needed, upgrade any spare TSC cards by installing the spare in the standby slot.

Caution When you insert a spare TSC card in the standby slot, a software mismatch alarm is raised. The working 
software on the active TSC card is then copied to the standby TSC, causing the standby TSC card to reset. 
When the standby TSC card reset completes, the standby TSC is running the same software version as 
the active TSC card.

Note You can activate only one node at a time; however, you can begin activation of the next node as soon as 
the TSC cards for the current node have rebooted successfully (wait 5 minutes from the time the 
SYSBOOT alarm is raised).

Step 16 Backup the Software R8.0 database, using the “NTP-U506 Back Up the ONS 15600 SDH Software 
Database” procedure on page 4, and substituting Software R9.2.1.x for Software R8.0.

Stop. You have completed this procedure.

Step 17 Return to your originating procedure (NTP).

DLP-U574 Perform an MS-SPRing Lockout

Note During activation, MS-SPRing spans are not protected. You must leave the MS-SPRing in the lockout 
state until you have finished activating all nodes in the ring, but you must be sure to remove the lockout 
after you have finished activating.

Note To prevent ring or span switching, perform the lockout on both the east and west spans of each node.

Step 1 Start CTC, if it is not already started.

Purpose If you have an MS-SPRing provisioned, before beginning the upgrade you 
must perform a span lockout at each node in the ring.
The database must be backed up prior to locking the MS-SPRing.

Tools/Equipment PC or UNIX workstation, Software R9.2.1.x files

Prerequisite Procedures NTP-U506 Back Up the ONS 15600 SDH Software Database, page 4

(MS-SPRing nodes only) The database must be backed up prior to locking 
the ring.

Required/As Needed Required for MS-SPRing only

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Maintenance and above
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DLP-  U575 Download the ONS 15600 SDH Software
Note The Software R8.0 CTC launches only when using the JRE 1.5.0 version. See the “DLP-U576 Activate 
the New ONS 15600 SDH Software” task on page 11 for information about how to change Java versions.

Step 2 Back up the database. See the “NTP-U506 Back Up the ONS 15600 SDH Software Database” procedure 
on page 4 for details.

Step 3 In node view, click the Maintenance tab, and click the MS-SPRing button.

Step 4 For each of the MS-SPRing trunk (span) cards (STM-16, STM-64), perform the following steps:

a. Next to the trunk card row, click the East Switch column to show the drop-down list.

b. From the menu options, choose Lockout Protect.

c. Click Apply.

d. In the same row, click the West Switch column to show the drop-down list.

e. From the menu options, choose Lockout Protect.

f. Click Apply. 

Note Ignore any Default K alarms that occur on the protect STS time slots during this lockout period.

Note Certain Multiservice Switching Platform (MSSP) related alarms might be raised following activation of 
the first node in the ring. The following alarms, if raised, are normal and should not cause concern. They 
clear upon completion of the upgrade, after all nodes have been activated.

• MSSP-OSYNC (MN)

• RING-MISMATCH (MJ)

• APSCDFLTK (MN)

• MSSP-RESYNC (NA)

• MSSP-SW-VER-MISM

Step 5 Return to your originating procedure (NTP).

DLP-U575 Download the ONS 15600 SDH Software

Purpose This task downloads the software to the ONS 15600 SDH nodes.

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures NTP-U506 Back Up the ONS 15600 SDH Software Database, page 4

Required/As Needed Required

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser
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DLP-  U575 Download the ONS 15600 SDH Software
Note The download task does not affect traffic because the active software continues to run at the primary 
RAM location; therefore, you can download the software at any time.

Step 1 If CTC is not already running, start CTC.

Step 2 In node view, click the Alarms tab.

Step 3 Verify that the alarm filter is not on. Click the Filter tool at the lower-left of the window.

Step 4 The Alarm Filter dialog box appears. Click the check boxes to deselect any selections in the Show 
Severity section of the General tab.

Step 5 On the Alarms tab, check all nodes for existing alarms. Resolve any outstanding critical alarms before 
proceeding. If necessary, refer to the Cisco ONS 15600 SDH Troubleshooting Guide.

Step 6 If the TSC card in Slot 5 is the active TSC, you will need to perform a soft reset to make the TSC in 
Slot 10 the active TSC. Select Slot 5, then right-click to display a shortcut menu. Click the Soft reset 
Card button. The reset takes a few minutes, and resets the TSC card in Slot 10 as the active TSC.

Note The TSC card can take several minutes to reboot. 

Step 7 If not in node view, open the View menu and choose Go to Home View to go to the node view.

Step 8 Click the Maintenance tab and then click the Software button.

Step 9 Click the Download button. The Download Selection dialog box appears.

Step 10 Click the Browse button.

Step 11 In the Open dialog box, navigate to the software package files on the ONS 15600 SDH software CD or 
on your hard drive, if you are working from a local copy. 

Step 12 Select the file with the PKG extension and click the Open button. 

Step 13 In the Download Selection dialog box, verify that the node is selected, then click OK. The software 
begins downloading to the active TSC card, and the TSC card in Slot 10 is highlighted. 

Step 14 Click the History tab to view the conditions:

1. Downloading (approximately 10 to 20 minutes) 

2. System Upgrade in progress (approximately 3 to 5 minutes)

Step 15 Click the Maintenance tab and then click the Software button. The Download Status column shows the 
percentage of the completion of the upgrade progress.

When the Download Status column is empty, the software has finished loading. 

Step 16 Verify that the Working Version field shows the pre-upgrade Software R8.0 version, and that the 
Protect Version field shows Software R9.2.1.x. 

Step 17 Repeat Steps 1 through 16 for each node.

Note The software download process can take 15 minutes or more per node.

Step 18 Return to your originating procedure (NTP).
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DLP-  U576 Activate the New ONS 15600 SDH Software
DLP-U576 Activate the New ONS 15600 SDH Software

Note Although the software activation task is not service affecting, Cisco recommends that you activate the 
new load during a maintenance window. 

Caution Do not perform maintenance or provisioning activities during the activation task.

Note For MS-SPRing nodes only, a non-service affecting APS-CHAN-FAILURE alarm is raised on each of 
the nodes joined to an activating node in the ring during activation. After the activation completes for 
that node, the alarms will clear. 

Note Cisco recommends that the first node you activate be a LAN-connected node. This ensures that the new 
CTC JAR files will download to your workstation as quickly as possible.

Step 1 If CTC is not already running, use the IP address of the ONS 15600 SDH node to start CTC.

Step 2 In node view, click the Maintenance tab and then click the Software button.

Step 3 Verify that the version in the Protect Version column is Software R9.2.1.x.

Step 4 Click the Activate button. The Activate dialog box appears with a warning message indicating that you 
should perform a database backup before proceeding.

Step 5 Make sure the TSC card in Slot 10 is active, if not, perform a soft reset on TSC card in Slot 5. 
Select Slot 5, then right-click to display a shortcut menu. Click the Soft reset Card button. The reset 
takes a few minutes, and resets the TSC card in Slot 10 as the active TSC.

Note The TSC card can take several minutes to reboot. 

Step 6 Complete one of the following:

Purpose This task activates Software R9.2.1.x in each node in the network. 
Activating the software load downloads the software to the standby TSC1.

1. If you have downloaded the software into the protect side of the TSC card and want to activate (or revert) it at a later time, 
the Activate (or Revert) buttons may be grayed out. This occurs when the Cisco ONS 15600 node detects the software in the 
protect side of the TSC as invalid. In order to activate (or revert) the software, download the software to the TSC card once 
again.

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures NTP-U506 Back Up the ONS 15600 SDH Software Database, page 4

DLP-U575 Download the ONS 15600 SDH Software, page 9

Required/As Needed Required

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser
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DLP-  U576 Activate the New ONS 15600 SDH Software
• If you have not backed up the database for the Working TSC B card, click the No button. Complete 
the “NTP-U506 Back Up the ONS 15600 SDH Software Database” procedure on page 4. When you 
have completed the procedure, return to Step 4 in this task.

• If you have backed up the database for the Working TSC B card, click Yes to proceed with the 
activation. The Download Status column shows: 

– A Qualifying message, indicating the percentage of qualification completed (approximately 1 
to 2 minutes).

– A Wait message, generated when the standby TSC card containing the upgrade software 
reboots. It signals to the active TSC card that it is ready to take over. When the active TSC 
receives this signal, it resets itself, and the standby TSC in Slot 5 takes over and transitions to 
the active software version. The pre-upgrade version of the TSC card is now the standby TSC. 

– An Acquiring message, indicating the percentage completed as the standby TSC acquires the 
active timing reference (approximately 10 to 15 minutes).

Step 7 Click OK when the Rebooting dialog box appears indicating that the software is successfully activated. 
The node reboot could take up to four minutes.

Step 8 A Connection Lost dialog box appears, indicating that the connection between the node and CTC is not 
currently active. Click OK in the Connection Lost dialog box. 

Note CTC loses connection to the node while the node reboots and displays the network view. The 
node might take several minutes to reboot. A Minor loss of connection between the node and 
CTC alarm appears in the History tab. Next, a CTC and node incompatible alarm is raised. Wait 
for node reactivation.

Step 9 In CTC, choose Exit from the File menu to exit, or proceed to Step 9 to delete the CTC cache.

Step 10 In CTC Launcher browser window, click the Delete CTC Cache button.

Note You must ensure that CTC is closed before clicking the Delete CTC Cache button. CTC behavior 
is unreliable if the button is clicked while the software is still running.

Note It might also be necessary to delete cached files from your browser’s directory, or from the temp 
directory on your MS Windows workstation. If you have trouble reconnecting to CTC, complete 
the “DLP-U577 Delete Cached JAR Files” task on page 13.

Step 11 Close your browser.

Step 12 Install JRE 5.0, in order to run CTC with ONS 15600 SDH Software R9.2.1.x and (optionally) run the 
Cache Loader pre-caching utility:

Note Cisco recommends you run the optional Cache Loader pre-caching utility during this step, prior 
to activating the node. This ensures that the new CTC JAR files download to your workstation 
as quickly as possible.

a. In your Windows environment, click Start > Control Panel > Add/Remove Programs.

b. Scroll the list of programs until you see older version of the Java Runtime Environment, then click 
Change/Remove.
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DLP-  U577 Delete Cached JAR Files
c. Click Yes in the dialog box to proceed with removing the old JRE version.

a. Load the Software R9.2.1.x CD into your CD-ROM drive. If the directory of the CD does not open 
automatically, open it.

b. Double-click the setup.exe file to run the Installation Wizard. The CTC installation wizard dialog 
box opens.

c. Click Next. The setup options dialog box opens.

d. Choose Custom, and click Next. The custom options dialog box appears.

e. Click Cisco Transport Controller, Java Runtime Environment 5.0, and (optionally) CTC JAR 
files. Click again to deselect any other selected options. 

f. Click Next. A confirmation dialog box appears.

g. Click Next again. The (optional) CTC Cache Loader pre-caches the JAR files to your workstation, 
displaying a progress status box, and installs the JRE.

h. When the installation finishes, click OK, and then in the wizard, click the Finish button.

Step 13 Reopen your browser.

Step 14 Return to your originating procedure (NTP).

DLP-U577 Delete Cached JAR Files

Step 1 Delete all cached files from your browser directory.

In Netscape:

a. Choose Edit > Preferences, click the Advanced tab, and then click the Cache button.

b. Click Clear Memory Cache.

c. Click OK.

d. Click Clear Disk Cache.

e. Click OK twice.

In Microsoft Internet Explorer:

a. Choose Tools > Internet Options and then click the General tab.

b. Choose Delete Files.

c. Click the Delete all offline content check box.

d. Click OK twice.

Purpose This task deletes previously cached files from your browser and hard 
drive. 

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level None
13
Upgrading the Cisco ONS 15600 SDH to Release 9.2.1

OL-23757-01



 

DLP-  U578 Install the Public-Key Security Certificate
Step 2 Close your browser.

You cannot delete cached JAR files from your hard drive until you have closed your browser. If you have 
other applications open that use JAR files, you must also close them.

Step 3 (Windows systems only) Delete cached files from your workstation.

a. In the Windows Start menu, choose Control Panel > System and select the Advanced tab.

b. Click the Environment Variables button. The resulting dialog box shows you a list of user variables 
and a list of system variables.

c. In the list of user variables, look for the TEMP variable. The value associated with this variable is 
the path to your temporary directory where JAR files are stored.

d. Open the TEMP directory located in the path you just looked up.

e. Select View > Details.

f. Click to select and delete all files with “jar” in the Name or Type field.

Step 4 Reopen your browser. You should now be able to connect to CTC.

Step 5 Return to your originating procedure (NTP).

DLP-U578 Install the Public-Key Security Certificate

Step 1 If CTC is not already running, start CTC.

Step 2 If the Java Plug-in Security Warning dialog box appears, choose one of the following options:

• Grant This Session—Installs the public-key certificate to your PC only for the current session. After 
the session is ended, the certificate is deleted. This dialog box will display the next time you log into 
the ONS 15600 SDH.

• Deny—Denies permission to install the certificate. If you choose this option, you cannot log into the 
ONS 15600 SDH. 

• Grant always—Installs the public-key certificate and does not delete it after the session is over. 
Cisco recommends this option.

• View Certificate—Allows you to view the public-key security certificate.

Step 3 Return to your originating procedure (NTP).

Purpose This task installs the ITU Recommendation X.509 public-key security 
certificate. The public-key certificate is required to run Software R8.0 or 
later.

Tools/Equipment None

Prerequisite Procedures DLP-U577 Delete Cached JAR Files, page 13

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-U579 Accept the New Load

Step 1 If CTC is not already running, start CTC.

Step 2 In node view, click the Maintenance tab and then click the Software button.

Step 3 Click the Accept button. The acceptance process will take approximately 2 to 5 minutes.

Note You can reject the new software load by clicking the Cancel button. 

Note If the Cancel button is not active, the standby TSC has not finished acquiring the active timing 
reference. The acquire process can take approximately 10 to 15 minutes. When the acquire 
process completes, the Cancel button becomes active.

Step 4 On the Maintenance tab, click the Software button and verify the version:

a. Click the Info button.

b. In the Current Software Info dialog box, verify that the TSC B Working field shows the correct 
version. The TSC B Protect field should show the previous version. 

c. If the TSC B Working and TSC B Protect fields show none, click OK and click the Info button again 
after several minutes. Repeat until the TSC B software versions appear.

d. Click OK.

Step 5 Back up Software 8.0 using the “NTP-U506 Back Up the ONS 15600 SDH Software Database” 
procedure on page 4, substituting Software R9.2.1.x for Software R8.0.

Step 6 Return to your originating procedure (NTP).

DLP-U580 Remove the MS-SPRing Lockout

Purpose This task upgrades the standby TSC card.

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures DLP-U576 Activate the New ONS 15600 SDH Software, page 11

Required/As Needed Required

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser

Purpose Release the span lockouts on all MS-SPRing nodes. Complete this task 
after the new software load is activated on all nodes.
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Step 1 If CTC is not already running, start CTC.

Step 2 In CTC node view, click the Maintenance tab, and click the MS-SPRing button.

Step 3 For each of the MS-SPRing trunk (span) cards (STM-16 or STM-64), perform the following steps: 

a. Next to the trunk card row, click the West Switch column to show the drop-down list.

b. Choose Clear from the list.

c. Click the Apply button to activate the command. 

Note When removing a lockout, be sure to apply your changes each time you choose the Clear option. 
If you try to select Clear for more than one lockout at a time, you risk traffic loss on the first ring 
switch.

d. In the same row, click the East Switch column to show the drop-down list.

e. Choose Clear from the list.

f. Click Apply to activate the command. 

Step 4 Repeat this task as many times as necessary to remove all MS-SPRing span lockouts on the upgrade 
nodes.

Step 5 Return to your originating procedure (NTP).

DLP-U581 Set the Date and Time

Note If you are not using Simple Network Time Protocol (SNTP), the upgrade procedure can cause the date 
and time setting to change. If you are using SNTP, you do not need to perform this task.

Step 1 Start CTC.

Step 2 In node view, click the Provisioning tab, and click the General button.

Step 3 Set the correct date and time, then click the Apply button. 

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures DLP-U576 Activate the New ONS 15600 SDH Software, page 11

Required/As Needed Required for all MS-SPRing nodes that were locked for software upgrade

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser

Purpose This task resets the date and time at each node.

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser
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Step 4 Repeat Steps 2 and 3 for each remaining node.

Step 5 Return to your originating procedure (NTP).

NTP-U508 Restore the Previous Software Load and Database

Note If the version in both the Working Version and the Protect Version fields in CTC is Software R9.2.1.x, 
as you cannot revert to a previous software version.

Note The tasks to downgrade to a previous load are not a part of the upgrade. They are provided here as a 
convenience to those wishing to restore an earlier software load after an upgrade. If you have performed 
all necessary procedures up to this point, you have finished the software upgrade.

Note Before you upgraded to Software R9.2.1.x, you should have backed up the existing database at all nodes 
in the network (using the “NTP-U506 Back Up the ONS 15600 SDH Software Database” procedure on 
page 4). Cisco recommends that you record or export all critical information to your hard drive. 

Caution Downgrades are service affecting. 

Note A system-wide soft reset occurs after the Software 8.0 database is restored. All line (I/O) and matrix 
cards automatically soft reset. Existing traffic can be affected, depending on the circuit provisioning 
map.

Step 1 Start CTC using the IP address for an ONS 15600 SDH node that has been upgraded from Software R8.0 
to Software R9.2.1.x, and access the node view. For detailed instructions, refer to the Cisco ONS 15600 
SDH Procedure Guide.

Purpose This procedure returns the node to the software and database provisioning 
you had before you activated Software R9.2.1.x.

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures NTP-U487 Preparing to Upgrade to a New Release, page 2

NTP-U506 Back Up the ONS 15600 SDH Software Database, page 4

NTP-U507 Upgrade the ONS 15600 SDH Software, page 6

Required/As Needed As needed

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser
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Note To perform a downgrade from SoftwareR9.2.1.x, Software R8.0 must have been working at the 
time you activated to Software R9.2.1.x on that node. Also, a supported reversion restores the 
node configuration at the time of the previous activation. Thus, any configuration changes made 
after activation will be lost when you revert the software.

Step 2 Back up the Software R9.2.1.x database. See “NTP-U506 Back Up the ONS 15600 SDH Software 
Database” procedure on page 4.

Step 3 (MS-SPRing nodes only) Complete the “DLP-U574 Perform an MS-SPRing Lockout” task on page 8.

Note The MS-SPRing lockout must be completed for all nodes in all rings for which the 
ONS 15600 SDH is provisioned.

Step 4 For software reversion to a previous version only, download the ONS 15600 SDH Release 8.0 Software.

Step 5 Click the Revert button. The Database Restore dialog box appears.

Step 6 Click the Browse button. An Open dialog box appears.

Note To restore the database for a reverted software version, select the database for the reverted 
version.

Step 7 In the Open dialog box, navigate to a local PC directory or network directory where the backup database 
file is stored and click the Open button, then click OK. The Database Restore dialog box appears.

Note If alarms and performance were backed up, click the Alarms and Performance check boxes in 
the Database Restore dialog box.

Step 8 Click Yes in the confirmation dialog box. 

Step 9 Click the History tab to view the conditions:

1. Downloading (approximately 10 to 20 minutes) 

2. System Upgrade in progress (approximately 3 to 5 minutes)

Step 10 Click the Maintenance tab and then click the Software button. The Download Status column shows the 
percentage of the completion of the upgrade progress.

When the Download Status column is empty, Software R8.0 has finished loading. 

Step 11 Log out of CTC.

Step 12 Restart CTC with the Software R8.0 version, using the same IP address used in Step 1.

Step 13 Complete the “DLP-U580 Remove the MS-SPRing Lockout” task on page 15 for all MS-SPRing nodes 
in the network.

Step 14 Complete the “DLP-U579 Accept the New Load” task on page 15.

Step 15 Repeat Steps 1 through 14 for any other nodes you want to downgrade.

Note Restoring the database of the Software R9.2.1.x version from the Software R8.0 version is not supported.
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Stop. You have completed this procedure.

NTP-U509 Upgrade to the ONS 15600 SDH Software Using TL1

Note This procedure assumes you are upgrading using Release 6.x TL1 syntax. TL1 commands issued prior 
to software activation to Software R9.2.1.x will vary in syntax depending on the release you are actually 
upgrading from. To ensure that your syntax for each command is correct, use the TL1 syntax supplied 
in the Cisco ONS SDH TL1 Command Guide for your particular release when issuing the following 
commands:

• ACT-USER

• APPLY

• CANC

• COPY-RFILE

• REPT EVT FXFR

• OPR-PROTNSW-<STMN_TYPE>

• RTRV-COND-ALL

• RTRV-ALM-ALL

Note To perform an R9.2.1.x software download using TL1, you must first have an FTP server or a terminal 
emulation program like HyperTerminal running on your workstation. In the following conditions, the 
download (COPY-RFILE) command is different when downloading software to a gateway network 
element (GNE) or an end network element (ENE):

• - FTP is being used.

• - The server is set up with a login and password of FTPUSER1 and FTPUSERPASSWORD1.

• - The FTP server has an IP address of 10.1.1.1. 

• - The FTP server is running on the standard FTP port.

• - The software package is called “15600SDH-0xxx-xxxx-xxxx.pkg.”

Purpose This procedure upgrades the node software to Software R9.2.1.x using 
TL1, rather than CTC.

Tools/Equipment PC or UNIX workstation

Prerequisite Procedures NTP-U487 Preparing to Upgrade to a New Release, page 2

NTP-U506 Back Up the ONS 15600 SDH Software Database, page 4

Required/As Needed Optional

Onsite/Remote Onsite or remote (but in the presence of the workstation)

Security Level Superuser
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Note The GNE and ENE commands are as follows:

• When downloading software to a GNE, use a command similar to:

COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL, 
SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.1.1.1/15600-0xxx-xxxx-xxxx.pkg”;

• When downloading software to an ENE, use a command similar to:

COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL,
SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.111.11.1:2361@90.90.90.90/15600-0xxx-xxxx-xxxx
.pkg”;

The ":2361" after the FTP server IP address 10.111.11.1 denotes port 2361 on the server.

The software PKG file in the preceding example is located in the home directory of the FTP server. If 
the software PKG file is not in the home directory on the FTP server, insert the directory path where the 
software package resides between the last IP address and the PKG file in the command line. An example 
is shown here.

COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL,
SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.1.1.1:2361@90.90.90.90/CISCO/SOFTWARE/15600-0xxx-x
xxx-xxxx.pkg”;To use 

Step 1 To use TL1 commands, set up an FTP session or use HyperTerminal or a similar terminal emulation 
package to establish a session with the ONS 15600 SDH node. 

Step 2 Type the IP address for the node, using port 3083 or 2361.

The terminal emulation interface will display a Warning message and a command prompt (usually >). 
You issue TL1 commands at this prompt.

Step 3 Type the ACT-USER (Activate User) command in the TL1 request window to open a TL1 session:

ACT-USER:[<TID>]:<uid>:<CTAG>[::<pid>];

where:

• <TID> is the target identifier (optional).

• <UID> is the profile username (required).

• <CTAG> is the correlation tag that correlates command and response messages (optional).

• <PID> is the password identifier (required).

For example, in the TL1 command:

ACT-USER::CISCO99:100::PASSWORD;

ACT-USER is the activation command, CISCO99 is the user ID, 100 is the correlation tag (used to 
correlate commands to command responses), and PASSWORD is the password associated with the user 
ID.

A response message containing the CTAG that you specified indicates the completion status of the 
command.

Step 4 Select the IP address for the node, using port 3083 or 2361.
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Step 5 Type the COPY-RFILE command in the TL1 window or, if using HyperTerminal, click Transfer > 
Receive File, and click in the associated dialog box to select a file to receive. The COPY-RFILE 
command downloads a new software package from the location specified by the FTP URL into the 
inactive Flash partition residing on either of the TSC cards.

COPY-RFILE:[<TID>]:<SRC>:<CTAG>::TYPE=<xfertype>,[SRC=<src1>],[DEST=<dest>],[OVWRT=<ovwrt>
],[FTTD=<fttd>];

where:

• <UID> is the optical support system Operations Support System (OSS) profile username (required).

• <SRC> is the source AID (required).

• <CTAG> is the correlation tag that correlates command and response messages (optional).

• <TYPE> is the file transfer protocol (required).

• <SRC> specifies the source of the file to be transferred (required).

• <DEST> is the destination of the file to be transferred (required).

• <OVWRT> is overwrite. If <OVWRT> is yes, then files should be overwritten. If <OVWRT> is no, 
then file transfers will fail if the file already exists at the destination (required).

• <FTTD> is the URL format (required).

Step 6 Repeat Step 5 for all nodes to be upgraded.

Step 7 Look for the REPT EVT FXFR message in the TL1 window. REPT EVT FXFR is an autonomous 
message used to report the start, completion, and completed percentage status of the software download. 
REPT EVT FXFR also reports any failure during the software upgrade, including invalid package, 
invalid path, invalid user ID/password, and loss of network connection.

The format of the message is:

REPT EVT FXFR

   SID DATE TIME
A  ATAG REPT EVT FXFR
   "<FILENAME>,<FXFR_STATUS>,[<FXFR_RSLT>],[<BYTES_XFRD>]"
;

where:

• <FILENAME> indicates the transferred file path name and is a string.

• <FXFR_STATUS> indicates the file transferred status: Start, IP (in progress), or COMPLD.

• <FXFR_RSLT> indicates the file transferred result: success or failure. FXFR_RSLT is optional (the 
FXFR_RSLT is only sent when the FXFR_STATUS is COMPLD).

• <BYTES_XFRD> indicates the percentage transfer complete and is optional (the BYTES_XFRD is 
only sent when the FXFR_STATUS is IP or COMPLD).

Step 8 Complete “NTP-U487 Preparing to Upgrade to a New Release” procedure on page 2 for each node to be 
upgraded.

Step 9 Complete “NTP-U506 Back Up the ONS 15600 SDH Software Database” procedure on page 4 for each 
node to be upgraded.

Step 10 Lock out each MS-SPRing span on each node being upgraded using the following command.

OPR-PROTNSW-<STMN_TYPE>:[<TID>]:<AID>:<CTAG>::<SC>,[<SWITCHTYPE>][:<DIRN>]; 

where:

• <AID> identifies the facility in the node to which the switch request is directed.
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• <CTAG> is the correlation tag that correlates command and response messages.

• <SC> is the switch command that is to be initiated on the paths.

• <SWITCHTYPE> is the MS-SPRing switch type.

• <DIRN> is the direction of transmission in which switching is to be made and is relative to the 
SONET line or path identified by the AID. The default value is RCV and should be changed to BTH.

Note Some nodes might have more than one MS-SPRing. If this is the case, all MS-SPRing spans on 
all nodes being upgraded need to be locked out. Nodes that are not being upgraded do not need 
to have the MS-SPRing spans locked out. You must be aware of each span that is part of a 
MS-SPRing to make sure all necessary spans are locked out.

Note MS-SPRing lockouts must remain in place until the upgrade is complete for all nodes.

Note Ignore any Default K alarms that occur on the protect STS time slots during the lockout.

Note Certain MS-SPRing-related alarms might be raised following activation of the first node in the ring. The 
alarms, if raised, are normal, and should not cause concern. They clear upon completion of the upgrade, 
after all nodes have been activated.

Step 11 Verify that all necessary MS-SPRing spans on each node being upgraded have been locked out using the 
following command:

RTRV-PROTNSW-<STMN_TYPE>:[<TID>]:<AID>:<CTAG>[::::];

<AID> must not be null.

Step 12 Verify that there are no outstanding alarms or conditions on each node using the following commands:

RTRV-COND-ALL:[<TID>]:[<AID>]:<CTAG>::[<TYPEREQ>][,,,]; 

where:

<TYPEREQ> is the type of condition to be retrieved. A null value is equivalent to ALL.

RTRV-ALM-ALL:[<TID>]:[<AID>]:<CTAG>::[<NTFCNCDE>],[<CONDITION>],[<SRVEFF>][,,,]; 

where:

• <AID> identifies the facility in the node to which the switch request is directed.

• <CTAG> is the correlation tag that correlates command and response messages.

• <NTFCNCDE> is a notification code. A null value is equivalent to ALL.

• <CONDITION> is the type of alarm condition. A null value is equivalent to ALL.

• <SRVEFF> is the effect on service caused by the alarm condition. A null value is equivalent to ALL.

Resolve all issues before proceeding.
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Note You can only activate only one node at a time; however, in a parallel upgrade you can begin activation 
of the next node as soon as the controller cards for the current node have rebooted successfully. If you 
wish to perform a parallel upgrade remotely, wait five minutes for the controller cards to complete the 
reboot.

Step 13 Starting at the node farthest from the GNE, type the APPLY command to activate the system software.

APPLY:[<TID>]::<CTAG>[::<MEM_SW_TYPE>]; 

where:

• <TID> is the target identifier.

• <CTAG> is the correlation tag that correlates command and response messages.

• <MEM_SW_TYPE> indicates a memory switch action during the software upgrade. Valid values 
are: 

– MEM_SW_TYPE is ACT to activate.

– MEM_SW_TYPE is CANC to cancel the activation.

If the command is successful, the appropriate flash is selected and the TSC card reboots.

The following occurs:

• When the standby TSC card containing the upgrade software reboots (this can take up to 5 minutes). 

• When the reboot is completed, the standby TSC is now running the Software R9.2.1.x upgrade. The 
active TSC in Slot 10 is running Software R8.0. 

• The standby TSC acquires the active timing reference, which may take up to 15 minutes to 
accomplish. Then the active TSC in Slot 10 reboots, and the card in Slot 5 becomes active, using 
Software R9.2.1.x as the working copy. When the TSC card in Slot 10 resets, it is in standby mode, 
and is running the Software R8.0 version.

• All remaining cards in the shelf reset simultaneously, raising a SYSBOOT alarm while activation in 
progress. When all cards have reset, this alarm clears.

• When the common control cards have finished resetting and all alarms are cleared, you can proceed 
to the next step.

After the common control cards finish resetting and all associated alarms clear, you can safely proceed 
to the next step. (If you are upgrading remotely and cannot see the nodes, wait for 5 minutes for the 
process to complete, then check to ensure that related alarms have cleared before proceeding.)

Step 14 Perform Step 13 for each node that will be upgraded, moving from the furthest node from the GNE 
toward the GNE itself, which should be activated last.

Note You might have to log in ( and Step 3) to each node again to activate the software (Step 13).

Step 15 After all nodes have been activated, log in using CTC or Telnet ( and Step 3) and verify there are no 
outstanding alarms.

Step 16 Remove all MS-SPRing lockouts using the following TL1 command:

RLS-PROTNSW-<STMN_TYPE>:[<TID>]:<AID>::[::<DIRECTION>]; 

where:

• <AID> identifies the facility in the node to which the switch request is directed.
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• <CTAG> is the correlation tag that correlates command and response messages (optional).

• <DIRN> is the direction of transmission (transmit or receive). The possible values are:

– RCV—Receive direction only (default)

– TRMT—Transmit direction only

– BTH—Both transmit and receive directions

For example:

RLS-PROTNSW-STM16:PETALUMA:FAC-6-1:209::BTH;

Stop. You have completed this procedure.

Related Documentation
Use this document in conjunction with the following publications:

• Cisco ONS 15600 SDH Procedure Guide
Provides installation, turn up, test, and maintenance procedures

• Cisco ONS 15600 SDH Reference Manual
Provides technical reference information for cards, nodes, and networks

• Cisco ONS 15600 SDH Troubleshooting Guide
Provides a list of alarms and troubleshooting procedures, general troubleshooting information, and 
hardware replacement procedures

• Cisco ONS SDH TL1 Command Guide
Provides a full TL1 command and autonomous message set including parameters, AIDs, conditions 
and modifiers for the Cisco ONS 15454 SDH and ONS 15600 SDH

• Cisco ONS SDH TL1 Reference Guide
Provides general information, procedures, and errors for TL1 in the Cisco ONS 15454 SDH and 
ONS 15600 SDH

• Release Notes for Cisco ONS 15600 SDH Release 9.2.1
Provides caveats, closed issues, and new feature and functionality information

Obtaining Optical Networking Information
This section contains information that is specific to optical networking products. For information that 
pertains to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.

Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco Optical Transport Products Safety and 
Compliance Information document that accompanied the product. This publication describes the 
international agency compliance and safety information for the Cisco ONS 15454 system. It also 
includes translations of the safety warnings that appear in the ONS 15454 system documentation.
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Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is 
available in a CD-ROM package that ships with your product. The Optical Networking Product 
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What's New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at: 

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a 
free service and Cisco currently supports RSS version 2.0.

This document is to be used in conjunction with the documents listed in the “Related Documentation” section.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of 
Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The 
use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

© 2011 Cisco Systems, Inc. All rights reserved.
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